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LAB 2: DESIGNING PSEUDOCODE AND FLOWCHART     
              USING MICROSOFT WORD 
 

OBJECTIVES FOR STUDENTS 
 
 
1. Develop pseudocode using Microsoft Word software. 

[Membina kod sudo menggunakan perisian Microsoft Word.] 
 
2. Develop flowchart using Microsoft Word software. 

[Membina carta alir menggunakan perisian Microsoft Word.] 
 
3. Trace pseudocode and flowchart in order to determine the contents of the 

variables and the output.  
[Menjejak kod sudo dan carta alir untuk menentukan kandungan pemboleh 
ubah dan output algoritma.] 

 
4. Design a pseudocode or a flowchart with given problem. 

[Mereka bentuk  kod sudo dan carta alir bagi masalah yang diberikan.] 
 

ASSUMPTIONS 
 
5. Students have the basic experience in starting (booting) the computer. 

[Pelajar mempunyai pengalaman asas memulakan (but) komputer.] 
 
6. Students have the basic experience in loading and opening particular software 

in Microsoft Windows. 
[Pelajar mempunyai pengalaman asas memuat dan membuka perisian tertentu 
dalam Microsoft Windows.] 

 
 

LAB EXERCISES 
 
EXERCISE 1: DEVELOP THE PSEUDOCODE USING MICROSOFT WORD 
[LATIHAN 1: MEMBINA KOD SUDO MENGGUNAKAN MICROSOFT WORD] 
 
7. Loading the Microsoft Word software. 

[Memuatkan perisian Microsoft Word.] 
 

i. Load the Microsoft Word software into the main memory of the 
computer  (i.e. RAM).   
[Muatkan perisian Microsoft Word ke dalam ingatan utama komputer, 
iaitu RAM.] 

 
ii. To load the Microsoft Word software: 
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[Uuntuk memuatkan perisian Microsoft Word:] 
 

a. Click on the Start menu at the bottom-left of the screen. 
[Klik pada menu Start yang berada di bahagian bawah 
sebelah kiri skrin.] 

b. Choose Microsoft Word represented by the  icon 

[Pilih Microsoft Word yang diwakili oleh ikon ] 
 
 

The Microsoft Word software is displayed as in Figure 2.1 below: 
[Perisian Microsoft Word dipamerkan seperti dalam Rajah 2.1 
berikut:] 
 

 
Figure 2.1  

 
8. Type the following pseudocode. 

[Taipkan kod sudo berikut.] 
 

 
 
 OR  

[Atau] 
 

Algorithm 2.1 : To calculate the total of three numbers 
1. Start 
2. Set TOTAL to 0 
3. Read NUMBER1 
4. Read NUMBER2 
5. Read NUMBER3 
6. Add NUMBER1, NUMBER2 dan NUMBER3 and store in TOTAL  
7. Display TOTAL 
8. End 
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9. Save the pseudocode file. 

[Simpan fail kod sudo.] 
 

iii. To save a word document: 
[Untuk menyimpan dokumen word:] 

 
a. Click on the File menu. Select Save As as shown in Figure 2.2. 

[Klik pada menu File. Pilih pilihan Save As seperti  Rajah 2.2.] 
 

 
Figure 2.2  

 
b. Click twice on the folder that contains your files. Then type 

your word document filename. For example, 
KodSudoKira3Nom as in Figure 2.3 below: 
[Klik dua kali pada folder yang mengandungi fail-fail anda.  
Kemudian taipkan nama fail dokumen word. Sebagai contoh, 
KodSudoKira3Nom seperti Rajah 2.3 berikut:] 

 

Algoritma 2.2 : Mengira hasil tambah bagi tiga nombor 
1. Mula 
2. Setkan HASILTAMBAH bersamaan 0 
3. Baca NOMBOR1 
4. Baca NOMBOR2 
5. Baca NOMBOR3 
6. Tambah NOMBOR1, NOMBOR2 dan NOMBOR3 dan simpan dlm 

HASILTAMBAH  
7. Paparkan HASILTAMBAH 
8. Tamat 
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Figure 2.3  

 
c. Click on the Save button 

[Klik bebutang Save] 
 
 
 
EXERCISE 2: DEVELOP THE FLOWCHART USING MICROSOFT        

  WINDOWS 
[LATIHAN 2: MEMBINA CARTA ALIR MENGGUNAKAN MICROSOFT 
WINDOWS] 
 
1. Move cursor to new page. 

[Gerak kursor ke halaman baru.] 
 

i. Apply the Page Break function: 
[Pilih fungsi Page Break.] 

 
a. On the Insert menu, select Break as shown in Figure 2.4.   

[Pada menu Insert, pilih pilihan Break seperti yang 
ditunjukkan dalam Rajah 2.4.] 

 

 
Figure 2.4 
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b. On the following dialogue box, select Page Break and click on 

the OK button. See Figure 2.5. 
[Pada kekotak dialog berikut, pilih pada Page Break dan klik 
pada bebutang OK. Lihat Rajah 2.5.] 

 

 
Figure 2.5 

 
2. Activate the Drawing submenu. 

[Aktifkan submenu Drawing.] 
 
3. Make sure that the Drawing submenu is activated.  If it is not active, on the 

View menu, select Toolbars and select Drawing as Figure 2.6 below: 
[Pastikan bahagian Drawing diaktifkan.  Jika tidak aktif, pada menu View, 
pilih Toolbars dan pilih Drawing seperti Rajah 2.6 berikut:] 

 

 
Figure 2.6  

 
If active, the Drawing submenu is normally found as a panel located at the 
bottom of the screen. 
[Sekiranya aktif, submenu Drawing lazimnya terdapat sebagai panel di 
bahagian bawah skrin.] 

 
4. On the Drawing panel, click on the text box icon. See Figure 2.7. 

[Pada panel Drawing, klik pada ikon kekotak teks. Lihat Rajah 2.7.] 
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Figure 2.7  

 
5. Draw a rectangular shape and label it with Start as below: 

[Lukis satu kawasan segi empat dan labelkannya sebagai Start seperti contoh 
berikut:] 

 

 
 
6. Change its shape to a terminal symbol by clicking on the Draw menu, select 

Change Autoshape, select Flowchart, select the terminator symbol. See 
Figure 2.8. 
[Ubah rupa supaya berbentuk simbol terminal dengan cara, klik pada menu 
Draw, pilih Change Autoshape, pilih Flowchart, pilih simbol terminator. 
Lihat Rajah 2.8.] 

 

 
Figure 2.8  

 
7. Draw the flowchart as in Figure 2.9: 

[Bina carta alir seperti Rajah 2.9:] 

Start 
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Figure 2.9  

 
This flowchart is a conversion from the pseudocode done in Exercise 1. 
[Carta alir ini ditukar daripada kod sudo yang telah di bina dalam Latihan 1.] 

 
8. Save the file as CartaAlirKira3Nom. 

[Simpan fail sebagai CartaAlirKira3Nom.] 
 
 
 
EXERCISE 3:  
[LATIHAN 3] 
 
1. Using the Microsoft Word software, develop the pseudocode as in Algorithm 

2.3 that converts the distance in mile to kilometer.  Then trace the content of 
the variables and determine the output of Algorithm 2.3. 
[Dengan menggunakan perisian Microsoft Word, bina kod sudo seperti 
Algoritma 2.3 yang menukarkan jarak dalam unit batu kepada kilometer.   
Kemudian jejak kandungan pembolehubah dan tentukan output Algoritma 2.3 
tersebut.] 

 

 

Algorithm 2.3: Convert the distance in mile to kilometer  
1. Start 
2. Set KM_PER_MILE to 1.609 
3. Set Distance_Mile to 100 
4. Convert the distance in mile to kilometers using the 

formula: 
  Distance_Kilo = KM_PER_MILE x Distance_Mile 
5. Display the distance in kilometer 
6. End 

START

Read NUM1, NUM2, 
NUM3

TOTAL = NUM1 + NUM2  
    + NUM3

Display TOTAL 

END
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2. Using the Microsoft Word software, develop a pseudocode that assigns values 

to variables as in Algorithm 2.4.  Then trace the content of the variables and 
determine the output of the Algorithm 2.4. 
[Dengan menggunakan perisian Microsoft Word, bina kod sudo yang 
mengumpukkan nilai kepada pembolehubah seperti Algoritma 2.4.   Kemudian 
jejak kandungan pembolehubah dan tentukan output bagi Algoritma 2.4 
tersebut.] 

 

 
 
3. Using the Microsoft Word software, develop a pseudocode that reads the 

radius of a circle, and computes the area of the circle as in Algorithm 2.5. 
[Dengan menggunakan perisian Microsoft Word, bina kod sudo seperti 
Algoritma 2.5 yang membaca jejari bagi suatu bulatan dan mengira luas 
kawasan bulatan tersebut.] 

 

 
 
i. Trace the content of the variables and determine the output of the 

Algorithm 2.5 if the input for Radius is: 
[Jejak kandungan pembolehubah serta tentukan output Algoritma 2.5 
sekiranya input jejari (Radius) ialah:] 
 
a. 3 
b. 10 
c. 150 

 
4. Using the Microsoft Word software, develop a pseudocode that reads the 

money collection of a user.  The algorithm computes the number of Ringgit 
and cents (50, 20, 10 5, and 1 cent) that can be extracted from the collection.  
Tips: You can use the Modulus operator that obtains the remainder from a 
division. 

Algorithm 2.5: Compute the area of a circle 
1. Start 
2. Set PI = 3.14159 
3. Read the Radius 
4. Calculate the area of a circle using the formula: 
 Area = Radius x Radius x PI 
5. Display Area 
6. End

Algorithm 2.4: Determine the content of variables  
1. Start 
2. Set Data1 = 5 
3. Set Data2 = 2.5 
4. Data3 = Data1 + Data2 
5. Data2 = Data3 x Data1  
6. Display Data1, Data2, Data3 
7. End
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[Dengan menggunakan perisian Microsoft Word, bina kod sudo yang 
membaca koleksi duit pengguna.  Algoritma tersebut mengira bilangan 
Ringgit dan syiling (50, 20, 10, 5, dan 1 sen) yang boleh diasing-asingkan 
daripada koleksi tersebut. Panduan: Anda boleh menggunakan operator 
Modulus untuk mendapatkan baki daripada hasil bahagi.] 

 
i. Trace the content of the variables and determine the output of 

Algorithm 2.6 if the input for the money collection is as follows: 
[Jejak kandungan pembolehubah serta tentukan output bagi Algoritma 
2.6 sekiranya input koleksi adalah seperti berikut:] 

 
a. 927 
b. 1274 
c. 6785 
d. 35565 

 

 

Algorithm 2.6: Compute Money Change from Collection to  
Ringgit and cents 
1. Start 
2. Read the Collection 
3. Determine the total for ringgit using the formula: 

    Ringgit = Collection / 100 
4. Determine the remaining amount using the formula: 

    Remain_Amt = Collection Modulus 100 
5. Determine the total 50 cents in the remaining  
 amount using the formula: 

    Fifty_Cent = Remain_Amt / 50 
6. Determine the remaining amount using the formula: 

    Remain_Amt = Remain_Amt Modulus 50 
7. Determine the total 20 cents in the remaining  
 amount using the formula: 

    Twenty_Cent = Remain_Amt / 20 
8. Determine the remaining amount using the formula: 

    Remain_Amt = Remain_Amt Modulus 20  
9. Determine the total 10 cents in the remaining  
 amount using the formula: 

    Ten_Cent = Remain_Amt / 10 
10. Determine the remaining amount using the formula: 

    Remain_Amt = Remain_Amt Modulus 10 
11. Determine the total 5 cents in the remaining  
 amount using the formula: 

    Five_Cent = Remain_Amt / 5 
12. Determine the remaining amount using the formula: 

          Remain_Amt = Remain_Amt Modulus 5 
13. Determine the total 1 cents in the remaining  
 amount using the formula: 

    One_Cent = Remain_Amt  
14. Display Collection, Ringgit, Fifty_Cent,  
    Twenty_Cent, Ten_Cent, Five_Cent, One_Cent 
15. End 
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EXERCISE 4:  
[LATIHAN 4] 
 
1. Using the Microsoft Word software, draw a flowchart as in Figure 2.10 that 

calculates the payment for normal and overtime working hours of an 
employee. Then trace the content of the variables and determine the output 
displayed from the algorithm. 
[Dengan menggunakan perisian Microsoft Word, lukiskan carta alir seperti 
Rajah 2.10 yang mengira bayaran untuk jam kerja normal dan lebih masa 
seseorang pekerja. Kemudian jejak kandungan pembolehubah dan tentukan 
output algoritma tersebut.] 

 

 
Figure 2.10  

 
 
 
 
 
 
 

START

Set NormalPayRate = 10.00 

Set NormalHours = 20  

Display TOTAL 

END

Set OvertimePayRate = 5.00 

Set OverTimeHours = 8  

Calculate TotalPay = NormalPayRate x 
NormalHours + OverTimePayRate x 

OverTimeHours  
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2. Using the Microsoft Word software, draw a flowchart as in Figure 2.11 that 
calculates the total cost of  item purchased. 
[Dengan menggunakan perisian Microsoft Word, lukiskan carta alir seperti 
Rajah 2.11 yang mengira jumlah harga sesuatu pembelian.] 

 

 
Figure 2.11 

 
 
 
 
 
 
 
 

Start

Read ItemName 

TotalCost = Quantity * PricePerUnit 

Read Quantity 

Read PricePerUnit

Read Payment 

PayChange = Payment - TotalCost 

Display ItemName, Payment, 
TotalCost and PayChange 

End

Display "Total 
payment"
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i. Trace the content of the variables and determine the output of the 
algorithm if the input values are as follows: 
[Jejak kandungan pembolehubah dan tentukan output algoritma 
tersebut sekiranya input adalah seperti berikut:] 
 
a. ItemName:  Pencil 

PricePerUnit: 0.50 
Quantity: 15 
Payment: 10.00 

 
b. ItemName: Note book 

PricePerUnit: 2.00 
Quantity: 5 
Payment: 50.00 

 
c. ItemName:  Pencil 

PricePerUnit: 3 
Quantity: 1 
Payment: 5.00 

 
 
EXERCISE 5:  
[LATIHAN 5] 
 
Given the following set of problems. Analyze each problem and identify the input, 
formula and the output. Write the pseudocode and draw the flowchart for the problem. 
[Diberi masalah-masalah seperti berikut. Analisis setiap masalah dan kenalpasti 
input, formula serta output.  Tuliskan kod sudo dan lakarkan carta alir bagi masalah 
berkenaan.] 
 
1. Read three numbers. Calculate the sum of those three numbers and find the 

average. Display all the three numbers, as well as the total of those numbers 
and the in average. 
[Baca tiga nombor. Kira dan jumlahkan ketiga-tiga nombor dan cari purata. 
Paparkan ketiga-tiga nombor, dan juga jumlah ketiga-tiga nombor serta 
puratanya.] 

 
Output: 
 
Input: 
 
Formula: 
 
Pseudocode design of the problem: 
 
Flowchart design of the problem: 
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2. Calculate the average weight of four students. Attempt to analyze this problem 
by stating it’s input, output and the formula required to determine the average 
weight. Display each student’s weight and the average weight calculated. 
[Cari purata berat bagi 4 orang pelajar. Paparkan berat setiap pelajar dan 
purata yang dikira. Cuba analisa permasalahan ini dengan menyatakan input, 
output serta formula yang diperlukan untuk mengira purata.] 

 
Output: 
 
Input: 
 
Formula: 
 
Pseudocode design of the problem: 
 
Flowchart design of the problem: 

 
3. Convert the time entered by the user in the form of day, hours and minute to 

minutes.  The conversion unit is as follows: 
1 day is equivalent to 24 hours  
1 hour is equivalent to 60 minutes 

[Tukarkan masa yang dimasukkan oleh pengguna dalam bentuk hari, jam dan 
minit ke minit. Pertukaran unit adalah seperti berikut: 

1 hari bersamaan dengan 24 jam 
1 jam bersamaan dengan 60 minit] 

 
Output: 
 
Input: 
 
Formula: 
 
Pseudocode design of the problem: 
 
Flowchart design of the problem: 

 
4. Convert the temperature entered by the user in the unit of Fahrenheit to the 

unit of Celcius.  The conversion formula is as follows:     
 
 
 

[Tukarkan suhu yang dimasukkan oleh pengguna ke dalam unit Fahrenheit 
kepada unit Celcius. Formula penukaran unit adalah seperti berikut:] 

 
Output: 
 
Input: 
 
Formula: 
 
Pseudocode design of the problem: 
 
Flowchart design of the problem: 

Celsius x   9   Fahrenheit = 
5

+ 32
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EXERCISE 6:  
[LATIHAN 6] 
 
Given the following problem. Analyze the problem and design its solution using 
structured chart. Then write the appropriate pseudocode or flowchart. 
[Diberi masalah berikut. Analisa masalah tersebut dan reka bentuk penyelesaiannya 
menggunakan carta berstruktur.  Kemudian, tuliskan kod sudo atau carta alir yang 
bersesuaian.] 
 
1. A student has designed an object as shown in Figure 2.12. You need to 

calculate both the perimeter and the area of the object, based on the length and 
the width of the rectangle entered by the user, as well as the height of the 
triangle. 
[Seorang pelajar telah mereka bentuk suatu objek seperti Rajah 2.12.   Anda 
perlu mengira perimeter dan luas objek tersebut berdasarkan kepada nilai 
panjang dan lebar segiempat yang dimasukkan oleh pengguna, serta nilai 
tinggi segitiga objek tersebut.] 

 

 
Figure 2.12  

 

 
 
 

Calculate the perimeter 
and area of an object 

Get the input  
values  

Calculate the 
total perimeter 

Calculate the 
total area 

Display the  
total perimeter 
and total area

Calculate the 
perimeter of 

circle 

Calculate the 
perimeter of a 
triangle side 

Calculate the 
area of triangle  

Calculate the 
area of circle 

Calculate the area 
of rectangle  
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